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Important Information

Warranty

The PXI-1000B, PXI-8176, and PXI-1411 are warranted against defects in materials and workmanship for a period of one year from the date
of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves
to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected.
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire,
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying,

recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National
Instruments Corporation.

Trademarks

CVI™, IMAQ™, LabVIEW™, National Instruments™, NI™, NI Display Test™, ni.com™, NI-IMAQ™, and TestStand™ are trademarks of
National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents

For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents. txt file
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY,
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS.
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN,
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Conventions

»

%
5

bold
italic

monospace

monospace italic

The following conventions are used in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.
This icon denotes a note, which alerts you to important information.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

Italic text in this font denotes text that is a placeholder for a word or value
that you must supply.
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Introduction to NI Display Test

This chapter introduces NI Display Test, teaches you how to set up the
NI Display Test application platform, and describes documentation
resources that can help you successfully develop your flat-panel display
inspection system.

@ Note If you did not purchase the standard application platform and want to build a display
inspection system from individual components, follow the installation instructions in the
NI Display Test Release Notes located in your software CD case. Then read ahead to the
Software Documentation section.

NI Display Test is an application platform created for people who need to
use automated visual inspection to evaluate flat-panel displays on such
equipment as cell phones, PDAs, vehicle panels, and computers. Research,
design, and validation engineers can use NI Display Test to perform
detailed analysis and functional performance tests on display prototypes.
Manufacturing test managers can use the platform to perform fast, reliable,
end-of-production tests with a proven system.

NI Display Test contains modules—or steps—of common display
inspection tasks that you can use to build a test sequence within National
Instruments TestStand. TestStand is a ready-to-run test executive for
organizing, controlling, and executing your automated prototype,
validation, or manufacturing test system. Within TestStand, you can
customize the NI Display Test steps to meet your needs, and you can
integrate your own tests into the sequence.

NI Display Test also ships with a library of C functions that you can use to
create your own display inspection steps. In order to use these functions,
you must have IMAQ Vision 6.0 for LabWindows™/CVI™ or later installed
on your computer.

© National Instruments Corporation 1-1 Getting Started with NI Display Test
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NI Display Test Components

The standard NI Display Test application platform comes with the
following components. All of the software components come installed with
your platform.

PXI-1000B—An 8-slot chassis that accepts both 3U PXI and
3U CompactPCI modules. The following modules come installed
in the PXI-1000B chassis:

PXI-8176 1.2 GHz Pentium III-based embedded controller.

PXI-1411 color or monochrome image acquisition device.

BNC and S-Video cables—Cables that connect the PXI-1411 to your
camera.

NI Display Test Application Software—The following pieces of
software form the NI Display Test application software.

TestStand—A test management system for organizing,
controlling, and executing your automated prototype, validation,
or manufacturing test system.

NI Display Test step types—Step types you can use inside
TestStand to configure and run Display Test functions.

NI Display Test function library—Functions for inspecting
flat-panel displays and their housing. The NI Display Test DLL
calls the IMAQ Vision run-time DLL for low-level image
processing. These functions are the foundation of the display
inspection steps that make up your test sequence.

IMAQ Vision Run-time DLLs—Run-time DLLs for National
Instruments machine vision and image processing software. For
more information about IMAQ Vision, visit ni . com/imaq.

NI OCR—Software for trainable optical character recognition.
For more information about NI OCR, visit ni . com/imag.

NI-IMAQ-—Driver software for National Instruments image
acquisition devices.

Measurement & Automation Explorer (MAX)—An interactive tool
for configuring National Instruments hardware devices.

@ Note For information about purchasing cameras, optics, and lighting, contact your
National Instruments sales representative.

Getting Started with NI Display Test
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Setting Up Your Application Platform

Before you begin creating and executing NI Display Test test sequences,
you need to set up and configure your application platform. Complete the
following steps to set up the components of your NI Display Test
application platform.

1. Carefully inspect the shipping container and the PXI-1000B for
damage. Check for visible damage to the metal work. Check to make
sure all handles, hardware, and switches are undamaged. Inspect the
inner chassis for any possible damage, debris, or detached
components. If damage appears to have been caused in shipment, file
a claim with the carrier. Retain the packing material for possible
inspection and/or reshipment.

2. Attach input power through the rear AC inlet of the PXI-1000B using
the appropriate line cord supplied.

3. Attach your camera to the PXI-1411 image acquisition device with the
provided BNC or S-Video cable or your own compatible cable.

4. Configure your acquisition through MAX.

a. Open MAX by double-clicking the Measurement & Automation
icon on your desktop.

b. Inthe MAX Configuration tree, expand Devices and Interfaces
and IMAQ PXI-1411 to see Channel 0.

c. Right-click Channel 0 and select your camera from the drop-down
menu.

d. Click the Properties button in the toolbar to view the properties
you can set for your camera.

Notice that Image Representation is set to HSL 32-bit by
default. The NI Display Test color processing functions process
color images in the HSL color space because it is faster and
provides more accurate information than the RGB color space.
If you need to inspect color features on your displays, use the HSL
color space. However, if you do not need to inspect color features,
set Image Representation to Luminance 8-bit.

@ Note If you purchased an IMAQ device apart from the Display Inspection platform,
Image Representation is set to RGB 32-bit.

e. Click the Snap button to acquire a single image. Notice that the
acquired HSL image does not look like a real-world representation
of the scene.
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&)

f. Set Image Representation to RGB 32-bit.

g. Click the Grab button to start a continuous acquisition. Notice
that the continuously acquired images now look like real-world
representations of the scene.

h. Click Grab again to stop the acquisition.

Set up your imaging environment such that it produces images with
enough quality to extract the necessary information about the displays
and housing under inspection. For more information, refer to
Appendix A, Setting Up Your Imaging Environment.

Tip Acquire continuous color images in the RGB color space while positioning your

lighting devices and focusing your camera to help you determine the best possible imaging
setup. Set Image Representation back to HSL 32-bit before acquiring images of the
displays you need to test.

Useful Documentation

NI Display Test comes with the following documentation resources to help
you set up your hardware, design test sequences, and run your display
inspection application.

Hardware Documentation

The following hardware manuals come with NI Display Test:

Getting Started with NI Display Test

PXI-1000B User Manual—Read this printed document to learn about
the features of the PXI-1000B mainframe and how to configure the
mainframe, install modules, and operate the mainframe.

Additional Information About Your PXI-1000B—Read this printed
document for supplemental information to the PXI-1000B User
Manual.

NI 8171 Series Installation Guide—Read this printed document for
information about installing your NI 8176 controller in a PXI chassis.
The NI 8176 controller comes installed with the purchase of a standard
NI Display Test platform.

NI 8171 Series User Manual—Read this PDF document for detailed
instructions about installing and configuring your National
Instruments NI 8176 embedded computer kit. You can access this
document from the Start menu.

IMAQ PCI/PXI-1411 User Manual—Read this printed document to
learn about the hardware functions on your PXI-1411 board, operation
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of each functional unit on the board, optional equipment and custom
cables, board specifications, and color concepts.

Software Documentation

The following NI Display Test application software documents come with
NI Display Test:

e Getting Started with NI Display Test—Read this printed document to
learn how to set up NI Display Test hardware, build a test sequence,
and run a test from within TestStand.

e NI Display Test User Guide—Refer to this help file to learn conceptual
information about NI Display Test, how each test works, which types
of patterns to generate for particular tests, and which parameter
settings to choose for each test. You can access this file by going to the
<Display Test>\Docs directory or by selecting it from Start»
Programs»National Instruments»Display Test»Documentation.

e NI Display Test Function Reference—Refer to this help file for
descriptions of the NI Display Test functions, structures, and
enumerations, as well as their parameters. You can access this file
by going to the <Display Test>\Docs directory or by selecting
it from Start»Programs»National Instruments»Display Test»
Documentation.

The following NI-IMAQ documents come with NI Display Test:

e NI-IMAQ User Manual—Refer to this PDF document for information
about NI-IMAQ, driver software that performs image acquisition and
processing without register-level programming. This document
contains example code, tips, and techniques to help you successfully
acquire images. You can access this document by going to the
<NI-IMAQ>\Docs directory or by selecting it from Start>Programs»
National Instruments» Vision»Documentation.

e NI-IMAQ Function Reference Manual—Refer to this PDF document
for information about high-level and low-level NI-IMAQ functions
and their parameters. You can access this document by going to the
<NI-IMAQ>\Docs directory or by selecting it from Start»Programs»
National Instruments» Vision»Documentation.

© National Instruments Corporation 1-5 Getting Started with NI Display Test



Chapter 1 Introduction to NI Display Test

The following TestStand documents come with NI Display Test:

Getting Started with NI Display Test

Getting Started with TestStand—Read this printed document to
familiarize yourself with the TestStand environment and the basic
TestStand features for building and running test sequences.

TestStand User Manual—Refer to this printed document for
information about TestStand concepts, techniques, and features.

Readme . txt—Read this file for information about installation,
programming considerations, and changes too recent to include in the
printed TestStand documentation. You can access this document by
going to the <TestStand>\Doc directory or by selecting the
appropriate document from Start»Programs»National
Instruments»TestStand»Readme Files.

TestStand Release Notes—Read this document for system
requirements, installation instructions, new features, and updated
information to help you begin using TestStand. You can access this
document by going to the <TestStand>\Doc directory or by
selecting the appropriate document from Start»Programs»National
Instruments»TestStand»Online Help.

TestStand Process Model—Read this PDF document for a detailed
overview of the architecture and implementation of the process models
that ship with TestStand. You can access this document by going to the
<TestStand>\Components\NI\Models\TestStandModels
directory and selecting TestStandProcessModel . pdf.

Operator Interface Manual—Refer to this document as a starting point
for a custom manual for operator interfaces that are based on the
TestStand operator interface examples. You can access this document
by going to <TestStand>\Doc and selecting
OperatorInterfaceManual .doc.

Operator Interface readme files—Use these files to familiarize
yourself with the general architecture and components of the operator
interface and to get information on how to make modifications to the
operator interface. TestStand ships with an operator interface readme
for LabWindows/CVI, LabVIEW, Delphi, and Visual Basic. You can
access these documents by going to <TestStand>\
OperatorInterfaces\NI and selecting the appropriate
subdirectory.
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Building an NI Display Test
Sequence

This chapter introduces the TestStand sequence editor interface and
describes how to create and run an NI Display Test test sequence in the
sequence editor. Follow the numbered instructions in this chapter to open
TestStand, build and configure an example test sequence, and run the
example test sequence.

Figure 2-1 shows the general steps to building an NI Display Test sequence
within TestStand.
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Open Sequence
Editor

Yy
Yes I_nsert a stgp No
that inspects display
ixels?
v P v

Insert custom step Insert Display Test
to generate a pattern step that inspects
on the display keypad or housing

v v
Select pattern to

display from Configure step
custom step

v

o | Insert Display Test step that
inspects display pixels for
the generated pattern

v

Configure step

Insert another
Display Test step
for the current
pattern?

Insert another Yes
Display Test step?

Save sequence

Run sequence to test
parameter settings

Figure 2-1. General Steps to Building an NI Display Test Sequence
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Chapter 2 Building an NI Display Test Sequence

Opening the TestStand Sequence Editor

Complete the following steps to open the TestStand sequence editor:

1.

© National Instruments Corporation

Launch TestStand by going to the Start system menu and selecting
Programs»National Instruments» TestStand»Sequence Editor.
After the sequence editor displays a main window, the Login dialog
box appears.

If the default user name is not administrator, click the User Name
control and select administrator from the popup list.

The default password for the administrator user login is empty,
so click OK without entering a password.
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Elements of the Sequence Editor

Figure 2-2 shows the sequence editor interface. The sequence editor has
four main parts: the menu bar, the toolbar, the development workspace, and
the status bar. For more information about these parts, refer to Chapter 2,
Sequence Editor Concepts, of the TestStand User Manual.

Toolbar Menu Bar

f TestStand \ Sequence Editor [Edit] - Sequence Filel _ (O] =]
File Edit “iew \Ezecute Debug Configure Source Contral Tool: Window Help
| == RN ||f§m DLL Flesible Prototype Adapter x] B i | 0o
i3 Sequence Filel [_[O] =]
Hain | Setup I Cleanupl Paramelersl Lucalsl Yiew: I@ MainSequence j

Step | Description | Execution Flow | Comment |

| Development
Workspace

[Mo Steps Selected |Number of Steps 02

Edit /User admiristrator  [Model: CAT estStandiComponentsiH WM odelsh T estStandModels S equer
Status Bar

Figure 2-2. Sequence Editor Main Window

Menu Bar

The menu bar contains the following menus: File, Edit, View, Execute,
Debug, Configure, Source Control, Tools, Window, and Help. Browse
the menus in the sequence editor to familiarize yourself with their contents.
For more information about each menu item, refer to Chapter 4, Sequence
Editor Menu Bar, of the TestStand User Manual.
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Toolbar

The toolbar contains shortcuts to commonly used commands on the menu
bar. As shown in Figure 2-3, the toolbar contains three sections: standard,
debug, and environment.

Standard Debug Environment
AN A AN
=" | b E| 7 [ RRE | E. 8 |‘§$ DLL Flexible Pratatype Adapter j| D = it

Figure 2-3. Sequence Editor Toolbar

* Standard section—Contains buttons for creating, loading, saving,
cutting, copying, and pasting sequence files.

*  Debug section—Contains buttons for executing a sequence, stepping
into, stepping over, stepping out of, pausing, and terminating an
execution.

*  Environment section—Contains the adapter selection ring, buttons
for opening other TestStand windows, and a button to bring an open
workspace to the front.

Development Workspace

The development workspace is the main area in the sequence editor. In this
area, the sequence editor displays child windows for each sequence under
development.

Status Bar

The status bar displays information about the state of the sequence editor.
As shown in Figure 2-4, the status bar contains three sections: selection
help, login display, and model display.

| [

Edit

'EMD' Selected Mumber of Steps: 1002

|User: administrator  [Modsl CAT estStand\Components\NIYModels\TestStandM odels\SequentialModel. seq 7

*

Selection Help

f f

Login Display Model Display

Figure 2-4. Sequence Editor Status Bar
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Selection Help—Displays the currently selected menu item or the
current execution state.

Login Display—Displays the user name of the current user.

Model Display—Shows the pathname of the process model file.

Building a Test Sequence

On startup, the sequence editor loads a blank sequence file. To build a test
sequence, you need to add configurable steps to the sequence file.

NI Display Test Steps

The TestStand Full Development System ships with a set of predefined
steps. For a description of the predefined TestStand step types, refer to
Chapter 10, Built-In Step Types, of the TestStand User Manual.

NI Display Test application software adds additional steps for testing
flat-panel displays and their housing. The following list describes
these steps:

Getting Started with NI Display Test

Load Simulation Image—Loads an image of a flat-panel display
from file. Use this step when you want to experiment with different
tests but you do not have your acquisition hardware set up.

Learn Calibration—Learns the perspective and lens distortion
present in the image of the display. The calibration information is
based on a grid template that is shown on the display. The step stores
the distortion information in a calibration template.

Correct Image Distortion—Corrects a distorted image by removing
perspective errors and lens distortion. The step uses a previously
learned calibration template to correct the image.

Alignment—Computes the location, orientation, and skew of the
display. It also can compute the location of the housing that surrounds
the display as well as the pixel gap between the display and the
housing.

Fiducial Based Alignment—Computes the location and orientation
of the display unit using user specified fiducials on the display.

Display Geometry—Computes the orientation and skew of the
display. It also can compute the location of the housing that surrounds
the display as well as the pixel gap between the display and the
housing. Use this step to find information about the display when you
use the Fiducial Based Alignment step to find the location of the
display unit.
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Pixel Defects—Detects defective rows, columns, or individual pixels.

Contrast—Computes the average intensities of the black regions and
the white regions of the display and then returns the absolute difference
between the mean black and mean white intensity values as the
contrast of the display pixels.

Icon Presence—Searches for areas in an image that match a given
grayscale or color icon.

Gross Defects—Locates, counts, and measures defects—such as
scratches and blemishes—in an inspection region.

OCR—Reads a string of characters on the display and determines
whether the string matches the expected output.

Segment Distortion—Locates groups, or segments, of display pixels
in an image and computes the distortion of the segments.

Character Verification—Finds characters in the image similar to a
pattern that you specify and determines the similarity between each
character and the pattern.

Grayscale Illumination—Divides the inspection region into
rectangular bins and computes the intensity statistics for each bin.
You can specify the number of bins you want to use.

Color Illumination—Divides the inspection region into rectangular
bins and computes the color statistics for each bin. You can specify the
number of bins in the inspection region and the color model you want
use to compute the statistics.

Housing Color—Compares the color of the display housing to a color
template.

Keypad Backlight—Computes the color statistics of the backlight.

Keypad Inspection—Searches areas in an image to verify that all the
keys on a keypad are present and of good quality.

Custom Pattern Generation Steps

The following NI Display Test steps inspect flat-panel displays for quality
pixels:

L]

© National Instruments Corporation

Alignment
Display Geometry
Pixel Defects
Contrast

Icon Presence
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Building an NI Display Test Sequence

*  Gross Defects

* OCR

e Segment Distortion

*  Character Verification
e Grayscale [llumination

¢ Color Illumination

By default, each of these steps displays a simulation image of a display
whose pixels are in a pattern conducive for the type of inspection that the
step performs. These simulation images are convenient when you want to
experiment with NI Display Test to see how it works.

For your real-world application, you need to create a code module that
generates patterns on the displays you want to inspect. You can incorporate
the pattern generation code module into your NI Display Test application
in two ways. The simpler way is to call the code module using a TestStand
Action step. To add an Action step, right-click in an open area of the
development workspace and select Insert Step»Action from the context
menu that appears. The better way is to wrap the pattern generation code
module in a custom step type. For instructions about creating a pattern
generation step type, refer to the NI Display Test User Guide.

Adding NI Display Test Steps to the Test Sequence

5

Complete the following steps to add NI Display Test steps to an example
test sequence.

Note In this example, you insert steps that load simulation images of displays instead of
custom steps that generate patterns.

1. Right-click in an open area of the Sequence File window, and select
Insert Step»Display Test»Load Simulation Image from the context
menu, as shown in Figure 2-5. TestStand gives the step a default name,
which appears highlighted immediately after you add the step to the
sequence.
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f Test5tand - Sequence Editor [Edit] - Sequence Filel M= 3

File Edit “iew Ewxecute Debug Configure Source Control Tool: ‘Window Help

Wiew: MainSequence j

Main |Setup I Eleanupl Parametersl Localsl

Step | Description | Execution Flow | Comment

¥ | #i- Load Simulation Image

Easte (B Tests 3 ﬁ" L Eellattan
Golp1 Level BkSpace @: el {{I— Correct Image Distartion
Open Tree View S
quence Call s

Browse Sequence Context... @ Stat " ﬁ" Alignment

AEMEN {{I— Fiducial B azed Alignment
Sequence Properties... & Label

GO Goto {{I— Dizplay Geometry

=] Message Popup {{I— Fixel Defects

xe| Call Executable £ Contrast
Property Loader B Icon Presence
N S oo 2]
Synchronization ¥
Datah 5 {{I— Gross Defects
atabase
v {{I— Segment Distortion
{{I— Character Yerification
{{I— Grayzcale lllumination
{{I— Calor lllumination

li

{{I— Houzing Color
{{I— Keppad B acklight
{{I— Keppad Inspection

Inzertz a new step created from thiz tppe at the end of the list |User: administrator |M0del: C:ATestStandiComponentshM 2

Figure 2-5. Selecting and Inserting an NI Display Test Step

2. Rename the step by typing Load Black Image while the default
name is highlighted. Renaming a step is optional. If you want to
rename a step after the name becomes deselected, right-click the step
name and select Rename from the context menu.

3. Add the following steps in order. When you are finished, the sequence
editor should look like Figure 2-6.

e Alignment

e Pixel Defects

¢ Load Simulation Image (rename Load Checkerboard Image)
e Contrast

¢ Load Simulation Image (rename Load Keypad Image)

¢ Keypad Inspection
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1= Sequence Filel = |_ (O] x]
I ain |Setup I Cleanupl F'alametersl Localsl lze I Main equence j
Step | Description | Execution Flow
-E‘fa!]- Load Black Image Selected Pattern: <Unconfigured:
ﬂﬂ-ﬁlignment Alighment: <Unconfigured: . Camera; <Mones
-E:{l- Pixel Defects Pixel Defects: <Uncaonfigured:, Camera: <Moke:
£ Load Checkerboard Image Selected Pattern; <Unconfigured:
-E‘fé]- Cantrast Cantrast: <Unconfigured:, Camera: <Mones
-E‘fa!]- Load Keypad Image Selected Pattern: <Unconfigured:
-E‘fa!]-éKeypad Inzpection K.eppad Inzpection: <Unconfigured: , Camera: <Mones:
END
1| | i
|Mo Steps Selected |Mumber of Steps: 72

Figure 2-6. Example Test Sequence

@ Note If you do not insert a Load Simulation Image step before an inspection step,
the inspection step uses the simulation image from the previous inspection step. In the
sequence you just created, the Pixel Defects step uses the same simulation image as the
Alignment step.

4. Select File»Save As, and save the sequence as DTexamplel.seq
in the <TestStand>\Tutorial directory.

Configuring an NI Display Test Sequence

Each Display Test step type has a unique configuration interface through
which you configure the parameters for each step type. You can access the
configuration interfaces by right-clicking the step you want to configure
and selecting Configure or by selecting the step and pressing <Ctrl-E>.

Configuration interfaces have an Image area in which you select the
different sources from which you can acquire a test image. Configuration
interfaces have various controls for you to set that determine the parameters
for the step, as well. Configuration interfaces also have a Measurements
area that returns measurements of the unit under test (UUT) and indicates
whether the UUT passes the step based on tolerances you set.
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Selecting a Pattern for the Alignment and Pixel
Defects Steps

Complete the following steps to select a display pattern conducive for both
the Alignment and Pixel Defects steps.

1. Right-click the Load Black Image step and select Select Simulation
Image from the context menu.

2. Select Black.bmp from the Sample Images ring control to load an
image of a UUT displaying black pixels.

3. Click OK to return to the sequence editor.
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Configuring the Alignment Step

1. Right-click the Alignment step and select Configure Alignment
from the context menu. A configuration interface appears, as shown
in Figure 2-7.

( Alignment Test
—Image
Source: g<8imulation>
¥ Acquire Mew Image
—Search P,
Dizplay Edge Strength: 'ﬂSD
Dizplay Edge Filter Width: :ﬂ 4
Diizplay Edge Slope: 'ﬁ 2
Display Edge Subsampling Interval: ﬁ2
Edge Search Direction; -:ilnside ta Outside
—I¥ “Housing Present
Houszing Edge Strength: 3 a0
Haousing Edae Filter Width: =
Housing Edge Slope: 3 i
Houzing Edge Subsampling Interval; § 2
— Compenzation
™ Leamn Intensity
I Measurements
Meazurement ‘ “alue | Law Limit | High Limit
Orientation Angle 3T [1.000 1.000
Skew Angle 460 [Too0  [loo0
tean Left Gap ; 10,000
tean Top Gap 10.000
tean Right Gap 10.000
tean Bottom Gap 10,000
7EEAETE 141 4 4
Set Inspection Region..; Update Image l p | Ok | Lancel | Help

Figure 2-7. Alignment Step Configuration Panel

Note When you open a configuration interface, the step begins to run with the default
settings, and the results of the step appear in the Measurements area of the configuration
interface.

2. Click the Image Source control. If you have an image acquisition
device installed in your computer, the name of the device should
appear in the list of image sources along with the default image source,
<Simulation>. For this example, use the default image source.
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3. Click Set Inspection Region. A window appears containing a default
region in which the function locates the display and its housing. You
can modify the position of the inspection region by manipulating its
control points or vertices with your cursor, as shown in Figure 2-8.

/ Select Inspection Region
o
11
8-bit image
®oBET
it
26
11

558
543

Ok

Cancel

Figure 2-8. Alignment Inspection Region

4. Click OK to return to the configuration interface.

Notice the Search Parameters area of the configuration interface.
The Alignment step uses an edge detection function to locate the
display housing by searching for edges from the outside of the
inspection region to the inside. The step also performs an edge
detection from the inside of the inspection region to the outside to
locate the display. The search parameters allow you to define the
characteristics of a valid edge and the specifications of a
properly-oriented display. For this example, use the default search
parameters.
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5

Building an NI Display Test Sequence

Set Display Region Inset to 2 to shrink the display region that the step
finds by two pixels on each side. By shrinking the display region, you
exclude unwanted pixels that belong to the gap between the display
and the housing. These unwanted pixels could interfere with
subsequent steps whose display regions are based on the display region
of this Alignment step.

Notice the Measurements area of the configuration interface. This
area shows you the values of the measurements you obtained from the
UUT and indicates whether the UUT passed the step.

Click OK to save the configuration and return to the sequence editor.

Configuring the Pixel Defects Step

1.

Right-click the Pixel Defects step and select Configure Pixel Defects
from the context menu. A configuration interface appears.

Click the Pattern Type control and select Uniform from the
drop-down list.

Notice that the green default inspection region automatically defines
the edges of the display. NI Display Test uses the display region found
by the Alignment step as the inspection region for the Pixel Defects
step.

Set the display and pixel resolutions. The display resolution is the
number of columns and rows of display pixels. The pixel resolution
is the number of columns and rows of image pixels that represent a
display pixel. For this example, enter the following values:

*  Display Height: 160
*  Display Width: 160
*  Pixel Height: 3
*  Pixel Width: 3

Note Use the default settings for the other parameters and tolerances.

4. Click OK to save the configuration and return to the sequence editor.

Getting Started with NI Display Test
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Selecting a Pattern for the Contrast Step

1. Right-click the Load Checkerboard Image step and choose Select
Simulation Image from the context menu.

2. Select Checkerboard.bmp from the Pattern Type ring control to
load an image of a UUT displaying a checkerboard pattern.

3. Click OK to return to the sequence editor.

Configuring the Contrast Step

1. Right-click the Contrast step and select Configure Contrast from the
context menu. A configuration interface appears, as shown in

Figure 2-9.
4 Contrast Test
—Image
Source: '_3§<Simulation>
¥ Aequire Mew Image
—Search P b
Fattern Type: —gﬁheckerboard
llntensity i ]
Edge Strength: g a0
Filter \width: g 4
Edge Slope: 32
[ i Border Size: _-_:;2
Measurement Type: gAbsolute Contrazt
1 Compensation
[~ Compenzate Intensity ‘
- . | —Contrast Measurement:
= i
| Meazurement Walue | Low Limit | High Limit
| Eontrast Value {87 anq120000 [255.000
76576141 4]
Set Inspection Regian... | Update Image | }'D | ok | Cancel | Help

Figure 2-9. Contrast Step Configuration Panel
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2. Click Set Inspection Region. A window appears containing a default
inspection region. The step uses checkers in this region to determine
the contrast of the image. You can modify the position of the inspection
region by manipulating its control points or vertices with your cursor.

Click OK to return to the configuration interface.

4. Adjust the border size up and down, and observe how the border size
affects the regions inside each checker. The smaller the border size, the
closer the region edges are to the edges of the checkers. Because the
edges between checkers appear blurred, they may interfere with the
intensity calculations.

5. Set Border Size to 4 to exclude the blurry checker edges when
calculating intensity values.

@ Note Use the default settings for the other parameters and tolerances.

6. Click OK to save the configuration and return to the sequence editor.

Selecting an Image for the Keypad Inspection Step

1. Right-click the Load Keypad Image step and choose Select
Simulation Image from the context menu.

2. Select Keypad.bmp from the Pattern Type ring control to load an
image of a cellular phone keypad.

3. Click OK to return to the sequence editor.

@ Note When you add steps to inspect the housing or keypad of a UUT in a real test
sequence, you do not need to precede those steps with a pattern generation step.

Configuring the Keypad Inspection Step

1. Right-click the Keypad Inspection step and select Configure
Keypad Inspection from the context menu. A configuration interface
appears.

@ Note In many applications that test both the flat-panel display and the housing or keypad,
separate cameras are used for the different inspection areas. If you use more than one
camera in your application to inspect different areas of the UUT, be sure to select the
correct camera from the Image Source control.

2. Click Set Template Regions. A window appears in which you can
select areas of the image that you want to learn as templates.
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3. Draw arectangular region around the key with a 1 printed on it.
Hold down the <Ctrl> key and draw regions around all of the other
number keys, as shown in Figure 2-10.

f Select Template Regions [ %]
X ,E
15
B-hit image:
% 570
Yo 347

0K
Cancel

Figure 2-10. Keypad Template Regions

4. Click OK to learn the templates and return to the configuration
interface.

@ Note Learning templates is a time-intensive operation. Please wait while NI Display Test
learns the templates you selected.

If the green default inspection region does not enclose all of the keys
you need to inspect, click the Set Inspection Region button and draw
an inspection region around all the keys.

5. In the Keypad Measurements section, set the Low Limit and High

Limit values of Number of Matches to 9 to look for all nine templates
in the image.

@ Note Double-click the Low Limit and High Limit values to edit them.
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10.

11.

Click OK. A dialog box appears prompting you to save the template
images to disk.

Click Yes. A Save Template File dialog box appears.

Select the <TestStand>\Tutorial directory from the Save in
control if it is not already selected.

Type key .png in the File name control. NI Display Test names
the template images key_n.png, where n is a unique number that
NI Display Test appends to each file name to distinguish it from the
other template images.

Click Save to save the template images and return to the sequence
editor.

Select File»Save to save the sequence.

Running a Sequence

Now that you have built a sequence of steps and configured each step, you
can run your sequence. When you run a sequence in the sequence editor,
you are initiating an execution. In this example, you run the sequence using
a process model—a special type of sequence for directing the high-level
sequence flow.

Complete the following steps to run the DTexamplel. seq sequence file.

1.

Getting Started with NI Display Test

Select Execute»Single Pass. The sequence editor opens the Execution
window, as shown in Figure 2-11. In an Execution window, you can
view steps as they execute, the values of variables and properties,
and the test report when the execution completes.
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Single Pass - DTExamplel.seq [4] [Running.._] _ O] x|

p§ Steps | m Contextl Heportl Threads: IMainSequence-Main [DTE=ample1. zeq) [0x4]

Step | Description | Statuz | Executic
-E‘fﬂ- Load Black Image Selected Pattern: C:%Program Files\Mational Inst...  Done
'E‘faﬂ-.-’-‘nlignment Alignment: Configured, Camera: <Simulated: Paszed
-E“;!]- Pixel Defects Pirel Defects: Configured, Camera: <Simulated: Pazzed
-E!l- Load Checkerboard Image  Selected Pattern: C:\Program Files\Mational Inst...  Done
-E“El- Contrast Contrazt: Configured, Camera; <Simulated: Passed
-4>-Er.ﬂ- Load Keypad Image Selected Pattern: C:%Program Files\Mational Inst...
-Efé]- Keypad Inspection Keypad Inspection: Configured, Camera: <Simul...
EMND
4| | i
Call Stack :l ‘watch Expression | Walue | Type |
-4> [8] MainSequence - Main [DTE xa
4| | »

[ |Current Step Index: 5 [Mumber of Steps: 72

Figure 2-11. DTexamplel.seq Execution Window

After the execution completes, TestStand generates a test report that
lists each step and whether the measurements within each step passed.
Figure shows the UUT Report for DTExamplel . seq.

2. Close the UUT Report and the Execution window.

@ Note To slow down the tracing feature of TestStand, select Configure»Station Options
and adjust the Speed slider control value on the Execution tab.
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Single Pass - DTExamplel.seq [2] [Completed] _ O] x|

p'fv Steps Report | Threads; IMainSequence - Main [DTExamplal. seq) [0x2] ﬂ
« 3 D fay -
Back Fonward Stop Refresh Home Fant size
UUT Report
+  Station ID:

+ Serial Mumhber: HOHE

. Date:Wednesday, Jdanuary 16, 2002

. Time:1:24:27 PM

+ Operator: administrator

. FExecution Time: 11.3745241 seconds

+ Number of Resulis: 7

+ UUT Resuli: Pas=sed |

Begin Sequence: MainSequence
(C:TestStand Tuterial\DTExample 1.seq)

|Status: ”Dcme |
|Status: ”Passed.
|Measu.r\ement:

| Meamrement [0] (Orentation):

| Lirmits:
Lenar: ”-1
High: |
nits: |[=gr==
Comparison Type: ||GELE (== ==)
Data: |Fo.107
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Meanrement[1] (Sleewr:

Linuts:
Larar: ”-1
High |E
Units: degree
Commparison Tvpe: GELE (== == ;I
@ | |Fie|:n:rt Location: CAT estStand\Tutonal\D TExample]_Report[1 24 2 2

Figure 2-12. UUT Report for Example Sequence
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Using the NI Display Test
Operator Interface

This chapter introduces the NI Display Test operator interface. You use the
operator interface to run your NI Display Test sequence on the
manufacturing floor.

The NI Display Test operator interface is based on the LabWindows/CVI

operator interface that ships with TestStand. Refer to Chapter 16, Run-Time
Operator Interfaces, of the TestStand User Manual for more information

about how to customize a run-time operator interface.

© National Instruments Corporation 3-1 Getting Started with NI Display Test



Chapter 3 Using the NI Display Test Operator Interface

Figure 3-1 shows the general steps to running an NI Display Test sequence

within the operator interface.

Open
operator interface

v

Open saved Display
Test sequence

v

Select operator
interface settings

v

Run sequence to test
Units Under Test

v

View
UUT Report

Figure 3-1. General Steps to Running an NI Display Test Sequence

Opening the NI Display Test Operator Interface

Complete the following steps to open the NI Display Test operator
interface:

1. Launch the NI Display Test operator interface by going to the Start
system menu and selecting Programs»National Instruments»
Display Test»Operator Interfaces. After the main window for the
operator interface displays, a Login dialog box appears.
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If the default user name is not administrator, click the User Name
control and select administrator from the popup list.

The default password for the administrator user login is empty,
so click OK without entering a password.

After you log in, the Sequence Display window appears, as shown in
Figure 3-2. You can open, view, and execute TestStand sequences from
the Sequence Display window.

i_{j-TeslStand Run-Time Operator Interface - Sequence Display

File Execute Debug Configure Toolz Window Help
Current Uzer: adrninistrator | 1/9/2002
5:54:27 PM
Seguence Dezcription: | Curent Test 0
—‘I Mumber of Tests: a
— Settings
v Display Image Window
Iv Display Failure Images in Repart

© National Instruments Corporation

Figure 3-2. NI Display Test Operator Interface

Browse through the menu options and notice that the operator interface
menus contain many of the commands available from the sequence
editor.

Like the sequence editor, the run-time operator interfaces allow you to
start multiple concurrent executions, set breakpoints, and single-step.
Unlike the sequence editor, however, the run-time operator interfaces
do not allow you to modify sequences, and they do not display
sequence variables, sequence parameters, step properties, and so on.
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Opening Sequence Files

Complete the following steps to open the sequence file you created in
Chapter 2, Building an NI Display Test Sequence.

1. Select File»Open Sequence File and navigate to the <TestStand>\
Tutorial directory.

2. Double-click DTexamplel. seq to open the sequence file.
The operator interface window appears, as shown in Figure 3-3.

i@ﬁ-TestSland Run-Time Operator Interface - Sequence Display [_ (O] x|
File Ezecute Debug Configure Toolzs ‘Window Help

Sequence File: DTExample.seq Jl Curment User: administrator | 1/9/2002

5 : MainS J| 6:01:01 PM
equence: ainequence Test ULTs [F5)

Step Group: b airy

_ |

Sinagle Pazs [Ctil+F5]

d Black

Alignment

Pixel Defects

Load Checkerboard Image
Contrast

Load FEevpad Image
Kevpad Inspection

End

-

Sequence Description:

{:!’]_ Currert Test: 1
:I = Murmber of Tests: 7

—Settings
¥ Display Imags ‘Window
¥ Display Failure Images in Feport

I

Figure 3-3. Example Sequence Loaded in Operator Interface

3. Select File»Open Sequence File and navigate to the
<Display Test>\Examples directory.

4. Double-click the DTFailSequence. seq to open it.

DTFailSequence. seqis asequence file included with your software
that contains an image that fails inspection.
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5. Notice that the Sequence File ring control shows the name of the
current sequence file that you are viewing. Click the control to see
a list of all sequence files open in the operator interface.

6. Select DTexamplel.seq from the Sequence File list to display the
sequence in the Sequence Display window.

Setting Image Display Options

The NI Display Test operator interface has two settings for displaying
images: Display Image Window and Display Failure Images in Report.
Verify that Display Image Window is selected so that the Execution
Display window shows the images captured by the NI Display Test steps.
Also verify that Display Failure Images in Report is selected so that the
UUT Report displays images that fail inspection.

@ Note By default, the Display Image Window and Display Failure Images in Report
settings are enabled.

Running Sequences

Now that you have opened the test sequences you want to run and have set
the image display options, you are ready to run the sequences on the
manufacturing floor. Complete the following steps to run
DTexamplel.seq in the NI Display Test operator interface:

1. Click the Single Pass button. An Execution Display window appears,
as shown in Figure 3-4.
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~ DTExampled_seq [2] (Running)

=

Sequence File: DTExamplel.zeq |
Sequence: MainS equence: |
Step Group: Main _!|
Stepz:
Doneg Load Black Image
Passed Alignment
Passed Pixel Defects
Done Load Checkerboard Imags
Passed Contrast

Load Eeyvpad Image

Kevpad Inspection
End

Break

Report;

Temminate

Abort

Threads: MainSequence - Main [DTExampIe‘I:seqj [0x2] _j|

Call Stack: MainSequence - Main [DTExamplel.seq) _J|
i

-E_'g]- Currant Test: 5 Mumber of Tests: - ?|

£

) Running

Viewing the Results of an Execution

Figure 3-4. Execution Display Window

The Execution Display window shows the progress of the execution.
You can use the Execution Display window to debug the execution, as
well. For information about debugging executions within the operator
interface, refer to the Operator Interface Manual.

2. Close the Execution Display window.

Click the Sequence File control and select DTFailSequence.seqg

from the drop-down list.

4. Click the Single Pass button to execute the DTFailSequence. seq

test sequence.

After an execution is finished, an HTML file containing a test report
appears in the Report control. To view the UUT report, click the
Launch Report Viewer button. Because the Display Failure Images in
Report control is enabled, the report contains images of the display during
tests that it failed, as shown in Figure 3-5.
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| Eilmﬁiew Favortes: Toolk Help |
| #=8ack - = - (D [2] 1} | DSeach CilFavoitss cHHiston | B~ S
| Address |1 C:\Progiam Files\National Instiuments"Display Test\Examples\T empFieport il =l @B || Links »
|
b, [—
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@] Darie

| S My Computer /

Figure 3-5. Excerpt of a UUT Report for a Defective Display
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@ Note You can log the results of an execution to a database. For more information, refer to
Chapter 18, Databases, of the TestStand User Manual. Refer to the NI Display Test User
Guide for additional instructions about logging results of the OCR step.
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Setting Up Your Imaging
Environment

Setting up your imaging environment is a critical first step to any imaging
application. If you set up your system properly, you can focus your
development energy on the application rather than problems from the
environment, and you can save precious processing time at run time.
Consider the following three elements when setting up your system:
imaging system parameters, lighting, and motion.

Fundamental Parameters of an Imaging System

Before you acquire images, you must set up your imaging system. Five
fundamental parameters comprise a imaging system: resolution, field of
view, working distance, sensor size, and depth of field. Figure A-1
illustrates these concepts.
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1 Resolution 3 Working Distance 5 Depth of Field 7 Pixel
2 Field of View 4 Sensor Size 6 Image

Figure A-1. Fundamental Parameters of an Imaging System

*  Resolution—Smallest feature size on your object that the imaging
system can distinguish

*  Field of view—Area of inspection that the camera can acquire
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¢ Working distance—Distance from the front of the camera lens to the
object under inspection

¢ Sensor size—Size of a sensor’s active area

¢ Depth of field—Maximum object depth that remains in focus

The manner in which you set up your system depends on the type of
analysis, processing, and inspection you need to do. Your imaging system
should produce images with high enough quality to extract the information
you need from the images. Five factors contribute to overall image quality:
resolution, contrast, depth of field, perspective, and distortion.

Resolution

Resolution indicates the amount of object detail that the imaging system
can reproduce. You can determine the required resolution of your imaging
system by measuring in real-world units the size of the smallest feature you
need to detect in the image.

Figure A-2 depicts a barcode. To read a barcode, you need to detect the
narrowest bar in the image. The resolution of your imaging system in this
case is equal to the width of the narrowest bar (w).

Wiov
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Figure A-2. Determining the Resolution of Your Imaging System

To make accurate measurements, a minimum of two pixels should
represent the smallest feature you want to detect in the digitized image.
In Figure A-2, the narrowest vertical bar (w) should be at least two pixels
wide in the image. With this information, you can use the following
guidelines to select the appropriate camera and lens for your application.

1. Determine the sensor resolution of your camera.

Sensor resolution is the number of columns and rows of
charge-coupled device (CCD) pixels in the camera sensor. To compute
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the sensor resolution, you need to know the field of view (FOV).

The FOV is the area under inspection that the camera can acquire.
The horizontal and vertical dimensions of the inspection area
determine the FOV. Make sure the FOV encloses the object you want
to inspect.

Once you know the FOV, you can use the following equation to
determine your required sensor resolution:

sensor resolution = (FOV/resolution) X 2
= (FOVi/size of smallest feature) X 2

Use the same units for FOV and size of smallest feature. Choose the
FOV value (horizontal or vertical) that corresponds to the orientation
of the smallest feature. For example, you would use the horizontal
FOV value to calculate the sensor resolution for Figure A-2.

Cameras are manufactured with a limited number of standard sensor
resolutions. The table below shows some typical camera sensors
available and their approximate costs.

Number of

CCD Pixels Cost FOV Resolution
640 x 480 $500+ 60 mm 0.185 mm
768 x 572 $750+ 60 mm 0.156 mm
1280 x 1024 $5,000+ 60 mm 0.093 mm
2048 x 2048 $22,000+ 60 mm 0.058 mm
3072 x 2048 $32,000+ 60 mm 0.039 mm

If your required sensor resolution does not correspond to a standard
sensor resolution, choose a camera whose sensor resolution is larger
than you require or use multiple cameras.

By determining the sensor resolution you need, you narrow the number
of camera options that meet your application needs. Another important
factor that affects your camera choice is the physical size of the sensor,
known as the sensor size. Figure A-3 shows the sensor size dimensions
for standard 1/3 Inch, 1/2 Inch, and 2/3 Inch sensors. Notice that the
names of the sensors do not reflect the actual sensor dimensions.
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Figure A-3. Common Sensor Sizes and Their Actual Dimensions

In most cases, the sensor size is fixed for a given sensor resolution.
If you find cameras with the same resolution but different sensor sizes,
you can determine the sensor size you need based on the following
guideline.

2. Determine the focal length of your lens.

A lens is primarily defined by its focal length. Figure A-4 illustrates
the relationship between the focal length of the lens, field of view,
sensor size, and working distance.

Field of

View Sensor
Size

Lens

<4+ P>4¢—>
Working Distance Focal Length

Figure A-4. Relationship Between Focal Length, FOV, Sensor Size,
and Working Distance
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The working distance is the distance from the front of the lens to the
object under inspection.

If you know the FOV, sensor size, and working distance, you can
compute the focal length of the lens you need using the following
formula:

focal length = sensor size X working distance/ FOV

Lenses are manufactured with a limited number of standard focal
lengths. Common lens focal lengths include 6 mm, 8 mm, 12.5 mm,
25 mm, and 50 mm. Once you choose a lens whose focal length is
closest to the focal length required by your imaging system, you need
to adjust the working distance to get the object under inspection in
focus.

Lenses with short focal lengths (less than 12 mm) produce images with
a significant amount of distortion. If your application is sensitive to
image distortion, try to increase the working distance and use a lens
with a higher focal length. If you cannot change the working distance,
you are somewhat limited in choosing your lens.

Example

As you set up your system, you need to adjust the various parameters of
the focal length equation until you achieve the right combination of
components that meet your inspection needs and cost requirements. The
following example shows how to determine the best combination of system
variables for a flat-panel display.

Assume that the flat-panel display you need to inspect is 56 X 56 mm with
a display pixel resolution of 160 X 160. The recommended minimum
number of image pixels you need to represent one display pixel is 3 X 3.
Therefore, you need an image whose size is at least 480 x 480 pixels.

The sensor size you choose is based on the minimum image size you need.
Therefore, you need a sensor whose resolution is 480 x 480 or greater.
Sensors come in several standard sizes. A1/2 in., 640 x 480 sensor would
be suitable for this example.
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Assume you already have a lens whose focal length is 16 mm.

Using the vertical FOV, you can determine the working distance,
as follows:

working distance = (Vpoy X focal length)/sensor size
= (56 x 16)/4.8

= 186.67 mm (~ 7.5 in.)

If you place the camera at a distance of 7.5 in. from the display under
inspection, you can calculate the horizontal FOV, as follows:

Hroy = (working distance X sensor size)lfocal length
= (186.67 x 6.4)/16

=74.67 mm

Therefore, a display that is 56 mm wide occupies a width of 480 image
pixels, as follows:

horizontal image pixels = (display width/Hy) X horizontal sensor size
= (56/74.67) x 640

=480

Therefore, the given settings satisfy the minimum requirements for
inspection.

Contrast

Resolution and contrast are closely related factors that contribute to image
quality. Contrast defines the differences in intensity values between the
object under inspection and the background. Your imaging system should
have enough contrast to distinguish objects from the background. Proper
lighting techniques can enhance the contrast of your system.
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Depth of Field

Perspective

The depth of field of a lens is its ability to keep in focus objects of varying
heights or objects located at various distances from the camera. If you need
to inspect objects with various heights, choose a lens that can maintain the
image quality you need as the objects move closer to and further from the
lens. You can increase the depth of field by closing the iris of the lens and
providing more powerful lighting.

Telecentric lenses work with a wide depth of field. With a telecentric lens,
you can acquire images of objects at different distances from the lens and
the objects stay in focus.

Visit the Web site of one of National Instruments’ lens partners for more
information about lenses:

¢ Edmund Industrial Optics—www . edmundoptics.com

e Graftek Imaging—www .graftek.com

e Infinity Photo-Optical—www. infinity-usa.com

¢ Navitar—www.navitar.com

Perspective errors occur when the camera axis is not perpendicular to the
object under inspection. Figure A-5a shows an ideal camera position.
Figure A-5b shows a camera acquiring an image of an object from an angle.

a. b.

1 Lens Distortion

2 Perspective Error 3 Known Orientation Offset

Figure A-5. Camera Angle Relative to the Object Under Inspection
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Figure A-6a shows a grid of dots. Figure A-6b illustrates perspective errors
caused by a camera imaging the grid from an angle.
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000000 ’,l”,l 0000 00O
[ 4
000000  ,,Y o0 e®@o0 00
a. Calibration Grid b. Perspective Projection c. Nonlinear Distortion
Figure A-6. Perspective and Distortion Errors
Try to position your camera perpendicular to the object under inspection
to reduce perspective errors. Integration constraints may prevent you from
mounting the camera perpendicular to the scene. Under these constraints,
you can still take precise measurements by correcting the perspective errors
with spatial calibration techniques.
Distortion

Nonlinear distortion is a geometric aberration caused by optical errors in
the camera lens. A typical camera lens introduces radial distortion. This
causes points that are away from the optical center of the lens to appear
farther away from the center than they really are. Figure A-6¢ illustrates the
effect of distortion on a grid of dots. When distortion occurs, information
in the image is misplaced relative to the center of the field of view, but the
information is not necessarily lost. Therefore, you can undistort your image
through spatial calibration.
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Lighting

One of the most important aspects of setting up your imaging environment
is proper illumination. Images acquired under proper lighting conditions
make your image processing software development easier and overall
processing time faster. One objective of lighting is to separate the feature or
part you want to inspect from the surrounding background by as many gray
levels as possible. Another goal is to control the light in the scene. Set up
your lighting devices so that changes in ambient illumination—such as
sunlight changing with the weather or time of day—do not compromise
image analysis and processing.

Lighting Techniques

The type of lighting techniques you select can determine the success or
failure of your application. Improper lighting can cause shadows and glares
that degrade the performance of your image processing routine. For
example, some objects reflect large amounts of light because of their
curvature or surface texture. Highly directional light sources increase the
sensitivity of specular highlights (glints), as shown on the barcode in
Figure A-7a. Figure A-7b shows an image of the same barcode acquired
under diffused lighting.

T
_.=u||“|;

l|[iJHH!H-’h .

Figure A-7. Using Diffused Lighting to Eliminate Glare

Ringlights provide high-intensity, uniform, shadow-free illumination in a
compact ring configuration. Ringlight illumination works well in display
inspection applications. You can use polarizers along with ringlights to
improve the contrast and reduce glare from reflective objects.
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Backlighting can help improve the performance of your vision system.

If you can solve your application by looking at only the shape of the object,
you may want to create a silhouette of the object by placing the light source
behind the object you are imaging. By lighting the object from behind, you
create sharp contrasts which make finding edges and measuring distances
fast and easy. Figure A-8 shows a stamped metal part acquired in a setup
using backlighting.

Figure A-8. Using Backlighting to Create a Silhouette of an Object

Common types of light sources that you can use to implement these lighting
techniques include halogen, LED, fluorescent, and laser.

Many other factors, such as the camera you choose, contribute to your
decision about the appropriate lighting for your application. For example,
you may want to choose lighting sources and filters whose wavelengths
match the sensitivity of the CCD sensor in your camera and the color of the
object under inspection. Also, you may need to use special lighting filters
or lenses to acquire images that meet your inspection needs.

To learn more about lighting techniques and decide which is best for your
application, visit the Web sites of National Instruments’ lighting partners:
¢ Edmund Scientific—www. edsci.com

¢ Fostec—www. fostec.com

¢ Graftek Imaging—www.graftek.com

e Illumination Technologies—www.illuminationtech.com
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Technical Support and
Professional Services

Visit the following sections of the National Instruments Web site at
ni.com for technical support and professional services:

© National Instruments Corporation

Support—Online technical support resources include the following:

—  Self-Help Resources—For immediate answers and solutions,
visit our extensive library of technical support resources available
in English, Japanese, and Spanish at ni . com/support. These
resources are available for most products at no cost to registered
users and include software drivers and updates, a KnowledgeBase,
product manuals, step-by-step troubleshooting wizards,
conformity documentation, example code, tutorials and
application notes, instrument drivers, discussion forums,

a measurement glossary, and so on.

—  Assisted Support Options—Contact NI engineers and other
measurement and automation professionals by visiting
ni.com/support. Our online system helps you define your
question and connects you to the experts by phone, discussion
forum, or email.

Training—Visit ni . com/training for self-paced tutorials, videos,
and interactive CDs. You also can register for instructor-led, hands-on
courses at locations around the world.

System Integration—If you have time constraints, limited in-house
technical resources, or other project challenges, NI Alliance Program
members can help. To learn more, call your local NI office or visit
ni.com/alliance.

Declaration of Conformity (DoC)—A DoC is our claim of
compliance with the Council of the European Communities using
the manufacturer’s declaration of conformity. This system affords
the user protection for electronic compatibility (EMC) and product
safety. You can obtain the DoC for your product by visiting
ni.com/hardref .nsf.
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*  Calibration Certificate—If your product supports calibration,
you can obtain the calibration certificate for your product at
ni.com/calibration.

If you searched ni . com and could not find the answers you need, contact
your local office or NI corporate headquarters. Phone numbers for our
worldwide offices are listed at the front of this manual. You also can visit
the Worldwide Offices section of ni . com/niglobal to access the branch
office Web sites, which provide up-to-date contact information, support
phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

m milli 10-3

CCD Charge-coupled device. A solid-state imaging device that stores an
electrical charge representation of the optical image by means of
photoconductivity. A readout mechanism converts the charge image into
a video signal.

code module A program module, such as a Windows Dynamic Link Library (.d11) or
LabVIEW VI (.v1), that contains one or more functions that perform a
specific test or other action.

context menu Menus that appear when you right-click an object. The menu items that
appear pertain specifically to the object you select.

E

execution An object that contains all the information TestStand needs to run a
sequence, its steps, and any subsequences it calls. Typically, the TestStand
sequence editor creates a new window for each execution.

Execution window A window in the sequence editor or operator interface that displays the
steps that an execution runs. When execution is suspended, the execution
window displays the next step to execute and provides single-stepping
options. In the sequence editor, you also can view variables and properties
for any active sequence context in the call stack.

HSL Color encoding scheme using Hue, Saturation, and Luma information
where each image in the pixel is encoded using 32 bits: 8 bits for hue, 8 bits
for saturation, 8 bits for luma, and 8 bits for the alpha channel.
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MAX

NI-IMAQ

0
OCR

operator interface

PNG

process model

RGB

Measurement & Automation Explorer. An interactive tool for configuring
National Instruments hardware devices.

Driver software for National Instruments IMAQ hardware.

A machine vision application that reads printed characters.

A program that provides a graphical user interface for executing sequences
at a production station. Sometimes the sequence editor and run-time
operator interfaces are different aspects of the same program.

Portable Network Graphic. Image file format for storing 8-bit, 16-bit, and
color images with lossless compression (extension PNG).

A sequence file you designate that performs a standard series of operations
before and after a test executive executes the sequence that performs the
tests. Common operations include identifying the UUT, notifying the
operator of pass/fail status, generating a test report, and logging results.

Color encoding scheme using red, green, and blue (RGB) color information
where each pixel in the color image is encoded using 32 bits: 8 bits for red,
8 bits for green, 8§ bits for blue, and 8 bits for the alpha value (unused).
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S

sequence

spatial calibration

step

step type

S-Video

T

TestStand

UUT

Glossary

A series of steps that you specify for execution in a particular order.
Whether and when a step is executed can depend on the results of
previous steps.

Assigning physical dimensions to the area of a pixel in an image.

Any action, such as calling a test module to perform a specific test, that you
can include within a sequence of other actions.

A component that defines a set of custom step properties and standard
behavior for each step of that type. All steps of the same type have the same
properties, but the values of the properties can differ. Step types define their
standard behaviors using substeps.

A type of color video transmission where timing and luma information are
transmitted on one analog signal and chroma is transmitted on a separate
analog signal.

A test management system for organizing, controlling, and executing your
automated prototype, validation, or manufacturing test system.

Unit under test. The device or component that you are testing.
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A

alignment step
configuring, 2-12 to 2-14
selecting pattern for defect steps, 2-11

BNC cable, 1-2
building test sequence, 2-1 to 2-20
adding NI Display Test steps to test
sequence, 2-8 to 2-10
alignment step
configuring, 2-12 to 2-14
selecting pattern, 2-11
configuring test sequence, 2-10 to 2-18
contrast step
configuring, 2-15 to 2-16
selecting pattern, 2-15
custom pattern generation steps, 2-7 to 2-8
general steps (figure), 2-2
keypad inspection step
configuring, 2-16 to 2-18
selecting image, 2-16
pixel defects step
configuring, 2-14
selecting pattern, 2-11
predefined steps, 2-6
running a sequence, 2-18 to 2-20
steps for testing flat-panel displays and
housings, 2-6 to 2-7
TestStand sequence editor, 2-3 to 2-6
elements, 2-4 to 2-6
opening, 2-3
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C

cables, 1-2
calibration certificate B-2
configuring application platform, 1-3 to 1-4
configuring imaging environment, A-1 to A-11
contrast, A-7
depth of field, A-8
distortion, A-9
fundamental parameters, A-1 to A-9
lighting, A-10 to A-11
perspective, A-8 to A-9
resolution, A-3 to A-7
configuring test sequence, 2-10 to 2-18
alignment step
configuring, 2-12 to 2-14
selecting pattern for defect steps, 2-11
contrast step
configuring, 2-15 to 2-16
selecting pattern, 2-15
keypad inspection step
configuring, 2-16 to 2-18
selecting image, 2-16
pixel defects step
configuring, 2-14
selecting pattern for defect steps, 2-11
contacting National Instruments B-2
contrast, setting up, A-7
contrast step
configuring, 2-15 to 2-16
selecting pattern, 2-15
conventions used in manual, iv
custom pattern generation steps, 2-7 to 2-8
customer
education B-1
professional services B-1
technical support B-1
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D

Declaration of Conformity B-1
depth of field, setting, A-8
diagnostic resources B-1
distortion, A-9
documentation
conventions used in manual, iv
hardware documentation, 1-4 to 1-5
online library B-1
software documentation, 1-5 to 1-6
drivers
instrument B-1
software B-1

E

example code B-1
executions
Execution Display window (figure), 3-6
UUT report for defective display
(figure), 3-7
viewing results, 3-6 to 3-8

F

flat-panel displays and housings
See also building test sequence
custom pattern generation steps,
2-7to0 2-8
test steps, 2-6 to 2-7

H

hardware documentation, 1-4 to 1-5
help
professional services B-1
technical support B-1
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image display options for operator
interface, 3-5
imaging environment, setting up, A-1 to A-11
contrast, A-7
depth of field, A-8
distortion, A-9
fundamental parameters, A-1 to A-9
lighting, A-10 to A-11
perspective, A-8 to A-9
resolution, A-3 to A-7
instrument drivers B-1

K

keypad inspection step
configuring, 2-16 to 2-18
selecting image, 2-16

KnowledgeBase B-1

L

lighting, setting up, A-10 to A-11

manual. See documentation
Measurement & Automation Explorer
(MAX), 1-2

National Instruments
calibration certificate B-2
customer education B-1
Declaration of Conformity B-1
professional services B-1
system integration services B-1
technical support B-1
worldwide offices B-2

ni.com



NI Display Test
building test sequence. See building test
sequence
components, 1-2
operator interface. See operator interface
overview, 1-1
setting up application platform, 1-3 to 1-4
NI Display Test application software, 1-2

0

online technical support B-1

operator interface, 3-1 to 3-8
example sequence loaded in interface

(figure), 3-4

Execution Display window (figure), 3-6
general steps for running (figure), 3-2
opening sequence files, 3-4 to 3-5
opening the interface, 3-2 to 3-3
overview, 3-1 to 3-2
running sequences, 3-5 to 3-6
Sequence Display window (figure), 3-3
setting image display options, 3-5
viewing results of execution, 3-6 to 3-8

P

perspective, setting up, A-8 to A-9
phone technical support B-2
pixel defects step
configuring, 2-14
selecting pattern for defect steps, 2-11
professional services B-1
programming examples B-1
PXI-1000B 8-slot chassis, 1-2
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Index

R

resolution, setting up, A-3 to A-7
camera sensor resolution, A-4 to A-5
example, A-6 to A-7
focal length of lens, A-5 to A-6
overview, A-3

running
sequences, 3-5 to 3-6
test sequence, 2-18 to 2-20

S

sequence editor. See TestStand sequence
editor
sequence files
example sequence loaded in operator
interface (figure), 3-4
opening, 3-4 to 3-5
running sequences, 3-5 to 3-6
setting up
application platform, 1-3 to 1-4
imaging environment, A-1 to A-11
test sequence, 2-10 to 2-18
software documentation, 1-5 to 1-6
software drivers B-1
software for NI Display Test, 1-2
support, technical B-1
S-Video cable, 1-2
system integration services B-1

T

technical support B-1

telephone technical support B-2

test sequence, building. See building test
sequence
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TestStand sequence editor, 2-3 to 2-6
development workspace, 2-5
main window (figure), 2-4
menu bar, 2-4
opening, 2-3
status bar (figure), 2-5 to 2-6
toolbar, 2-5

training, customer B-1

troubleshooting resources B-1

u

UUT report
defective display (figure), 3-7
example sequence (figure), 2-20
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W

Web
professional services B-1
technical support B-1
worldwide technical support B-2
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